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Pour votre sécurité

Lisez attentivement ce manuel afin d'utiliser cet appareil
correctement et d'éviter tout danger ou dommage matériel.

A AVERTISSEMENT Vous risquez de vous blesser gravement si vous ne tenez pas compte de

ces instructions.

ilisation de I'appareil

mauvaise utilisation peut provoguer des explosions,
des incendies ou des décharges électriques.

Ne prenez pas l'initiative de
démonter, réparer ou
modifier cet appareil vous-
méme.

Ne mouillez pas I'appareil et
ne le laissez pas tomber dans
I'eau.

Si l'appareil est mouillé, ne
I'allumez pas. Contactez un centre
de dépannage.

Ne posez pas I'appareil dans
un endroit humide,
poussiéreux ou couvert de
suie, sous peine de
provoquer un incendie ou une
décharge électrique.

Ne laissez pas I'appareil dans
un lieu ou la température
excede 35°C (comme un
sauna ou une voiture en
stationnement par exemple).
En été, la température a l'intérieur
d'une voiture peut atteindre 80°C.

Pour éviter les troubles au @!

L'utilisation prolongée de I'écouteur ou du casque
peut fortement réduire votre acuité auditive.

Si vous vous exposez & un volume sonore supérieur a 85 dB
pendant une durée prolongée, votre ouie sera
imémédiablement endommagée. Plus le son est élevé, plus
votre acuité auditive diminue (une conversation ordinaire a un
niveau sonore compris entre 50 et 60 dB alors que celui
provenant d'une route est d'environ 80 dB).

Il est fortement recommandé d'utiliser un volume sonore
moyen (le volume moyen est habituellement inférieur de 2/3
au volume maximal).

Si vous ressentez des bourdonnements dans les
oreilles, réduisez le volume ou n'utilisez plus
I'écouteur ou le casque.

Pour éviter tout risque d'acci e la route

N'utilisez pas I'écouteur lorsque vous conduisez une
bicyclette, une automobile ou une motocyclette.
Dans le cas contraire, vous risqueriez de provoguer un accident
grave. En outre, son utilisation est interdite par la loi dans
certaines régions. L'utilisation de écouteur dans la rue,
particulierement sur les passages pour piétons, pourrait
entrainer des accidents graves.

Pour votre propre sécurité, assurez-vous que le cable de
I'écouteur n'entrave pas vos mouvements ou ne

s'accroche pas dans des objets environnants lorsque

vous faites de I'exercice ou lorsque vous vous promenez.



A ATTENT|ON Suivez attentivement ces instructions sous peine de provoquer des blessures

physiques ou d'endommager I'appareil.

Utilisation de I'appareil
Utilisez votre appareil de fagon & éviter Evitez de causer des
tout dysfonctionnement ou tout acciden dysfonctionnements

Lorsque vous portez
I'appareil autour du cou,
n’exercez pas de pression
excessive sur la
cordelette.

Soyez vigilent lorsque vous
utilisez I'appareil sans le
capuchon USB.

La fiche métallique USB
possede des bords
tranchants et risque de
provoquer des blessures.

Gestion des données importantes

Veillez a toujours
enregistrer vos données les
plus importantes.

Notez bien que nous ne saurons étre
tenus responsables en cas de perte
des données due a une panne, a
une réparation ou a toute autre
cause.

Evitez tout impact brutal sur
I'appareil (ex. : en cas de
chute). Ne posez pas
d'objets lourds sur le dessus
de l'appareil.

Empéchez que des
particules externes ou de la
poussiere ne pénétrent
dans l'appareil.

Evitez toute projection d’eau
sur I'appareil. Ne nettoyez
jamais I'appareil a l'aide de
produits chimiques (ex. :
benzéne ou diluant) sous peine
de provoquer un incendie, une
décharge électrique ou une
détérioration de la surface.

Ne posez jamais I'appareil &

=
=< proximité d'objets émettant des

ondes électromagnétiques sous
peine de provoquer un
dysfonctionnement.
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Vérification de I'appareil et des accessoires i . N
Les schémas suivants sont destinés a vous

Vérlflcatlon des acceSSO|reS guider et peuvent légérement différer de

I'appareil lui-méme.
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Lecteur Ecouteurs CD d'installation

= L'aspect des accessoires est susceptible d'étre amélioré et modifié sans notification préalable.

S9410SS320k Sap 19 |1a1edde,| ap UOIRIIILIDA
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Vérification de I'appareil et des accessoires

Composants

| Face avant, coté droit et dessus de I'appareil

I—»

Bouton MENU/ Bouton de réglage du volume
de sélection

Trou de la cordelette

Capuchon USB

Fiche USB

Eclairage par LED

Ecran d’affichage

Bouton USER/d’enregistrement

Bouton d'alimentation et de
lecture/pause

Bouton de changement de plages/
recherche rapide



| Face arriére

(@]
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» Port de connexion des
écouteurs

/ #/— » Bouton de réinitialisation
|_ » Microphone

» Interrupteur Hold

Ecouteurs

S9410SS820k Sap 19 |1a1edde,| ap UOIIRIIILIDA
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Vérification de I'appareil et des accessoires

Affichage des informations a I'écran

| Musique

® © ® 0 06 1 Témoin de lecture/pause/arrét
| 1 | |

» 0009/0020 @RGEES A-~p @1

N

Témoin Numéro de la plage en cours/
nombre de plages total

Témoin de mode sonore

Témoin de répétition de la lecture

Singer - Song 1———
) (0:00:20 ’

Témoin de la pile
Témoin du titre de la plage en cours

(7] (5]

Barre d'état de la lecture

0 N o o b~ W

Témoin du temps de lecture



Vérification de I'appareil et des accessoires

Fonctions des boutons

Fonctions et utilisation

= Appuyez longuement sur le bouton pour allumer ou éteindre I'appareil.
= Appuyez brievement sur le bouton pour sélectionner Lecture/Pause.

= vs)
o
=
=4
o
>
"

= Appuyez longuement sur le bouton pour démarrer I'enregistrement vocal.

= Appuyez brievement sur le bouton pour utiliser les fonctions de réglage USER
— Repeat AB (Répétition AB)/DNSe (Egaliseur)/Play Speed (Vitesse de
lecture)/Play Mode (Mode de lecture)

‘-USERI-I

= Appuyez longuement sur le bouton pour accéder a I'écran de menu.
= Appuyez brievement sur le bouton pour accéder a la liste de navigation.

= Appuyez longuement sur le bouton effectuer un balayage rapide des plages.
= Appuyez brievement sur le bouton pour sélectionner la plage précédente ou
lire la plage en cours a partir du début.

= Appuyez longuement sur le bouton effectuer un balayage rapide des plages.
= Appuyez brievement sur le bouton pour passer a la plage suivante.

= Appuyez brievement sur le bouton pour augmenter le volume ou pour
accéder a I'élément / au menu supérieur.

= Appuyez brievement sur le bouton pour diminuer le volume ou pour accéder
a l'élément / au menu inférieur.

= Poussez I'interrupteur dans le sens de la fleche pour verrouiller les
fonctions des boutons.

$110S59008€ S9p 19 [1sedde,| ap uonedyoA I R )

Dd==B

= Appuyez sur le bouton a I'aide d'un objet pointu pour réinitialiser le

RESET -
o systéme.
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C h arg e m e nt d e | a batte r | e Chargez la batterie completement avant d'utiliser le

lecteur pour la premiére fois ou lorsqu'il n'a pas été
utilisé depuis longtemps.

Affichage a I'écran
= Chargement en cours...
= Chargement terminé

Otez le capuchon USB, puis reliez la fiche USB au port USB ( '{; ) de votre ordinateur.

= Le temps nécessaire a un chargement complet est d'environ deux heures et demie ; il peut
néanmoins varier en fonction de I'environnement installé sur l'ordinateur.

| utilisation de la batterie

= Rechargez et rangez I'appareil dans un lieu ot la température est comprise entre 5 et 35°C.

= Evitez de surcharger la batterie (12 heures au maximum). Charger ou décharger la batterie a des fréquences trop
rapprochées peut réduire sa durée de vie.

= Comme pour tout autre produit de consommation, la durée de vie de la batterie raccourcit progressivement avec le
temps.

= La connexion USB peut s'avérer instable si vous utilisez un concentrateur USB. Reliez directement la batterie au
port USB de votre ordinateur.



Utilisation de base

| Mise sous et hors tension de I'appareil

» 0009/0020 METENN NOR, @m Mise sous tension de 'appareil
Appuyez longuement sur le bouton [ &1 ].
= L'appareil sallume.

Singer - Song 1
) (00:00:20

Mise hors tension de I'appareil
Appuyez longuement sur le bouton [ &1 ].
= L'appareil s'éteint.

= |'appareil s'éteint automatiquement lorsque aucun des boutons n'est utilisé pendant une durée
feieRUE  predéfinie (par défaut : 10 secondes) en mode Pause (Pause). ~ Page 43

| Lire des fichiers musicaux

~ a3 1 Appuyez longuement sur le bouton [M] pour
36 ey accéder a I'écran de menu.
M Music 2 Appuyez sur le bouton [ +, - ] pour sélectionner

<Music> (Musique) 3.

3 Appuyez sur le bouton [M].
= Lalecture démarre.

(@)
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Utilisation de base (suite)

| Réglage du volume

» 0009 /0020 TR NoR,_ @]
Singer - Song 1
<o ):04

Appuyez sur le bouton [ +, - ] situé sur la face
avant du lecteur.
= La barre d'état du volume s'affiche.

= Appuyez sur le bouton [ +] pour augmenter le volume ou
sur le bouton [ —] pour le diminuer.

| Fonction Lock (Verrouillage)

™~
()
HOLD

En mode Hold, tous les boutons sont désactivés. Vous
apprécierez particulierement le coté pratique de cette
fonction lors de vos marches ou de vos courses a pied.

1 Poussez Il'interrupteur [HOLD] du lecteur dans le
sens de la fleche.

2 Poussez l'interrupteur [HOLD] dans le sens opposé
a celui indiqué par la fleche pour désactiver la
fonction Lock (Verrouillage).



| Recherche de fichiers via la fonction <Navigation>

Recherchez des fichiers en toute simplicité gréace la fonction <Navigation>.

(@)
=7
QD

=3
=
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=
o
=
D~

°
QO
2
£
o
=}

@~ . 1 Appuyez longuement sur le bouton [M] pour
E i @ i accéder a I'’écran de menu.
‘ Al le bouton [ +, - ] pour sélectionner
*| v Navigation ppuyez sur fe -
9 <Music> (Musique) & .

3 Appuyez sur le bouton [M].
= La liste des dossiers <Navigation> (Navigation) s'affiche.

aseq ap uonesi|nN

Appuyez sur le bouton [ +, - ] pour sélectionner le
dossier de votre choix.

5 Utilisez le bouton [~ ~I] pour accéder a la liste des
fichiers dans le dossier sélectionné.

= Utilisez le bouton [~ ~1] pour accédez au niveau inférieur
et sur le bouton [I"* ] pour accéder au niveau supérieur.

Appuyez sur le bouton [+, - ] pour sélectionner le
fichier de votre choix.

7 Appuyez sur le bouton [M].
= La lecture du fichier sélectionné démarre.

15



Utilisation de base (suite)

| Fonction Reset (Réinitialisation)

En cas de dysfonctionnement, vous pouvez
réinitialiser le systéeme en appuyant sur le
bouton Reset. ~ P50

16
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Importation de fichiers musicaux

Transfert de fichiers musicaux

Pour lire des fichiers musicaux, commencez par transférer les fichiers au format

MP3, WMA, Audio ASF, Ogg et autres formats compatibles depuis votre ordinateur
sur le lecteur MP3.

Suivez les étapes ci-dessous pour transférer des fichiers.

Transfert de fichiers musicaux

= Transfert de fichiers depuis votre ordinateur sur le lecteur en utilisant Media Studio
~ Page 26

= Transfert de fichiers depuis votre ordinateur sur le lecteur en utilisant les fonctions
«Copier» et «Coller» (disque amovible) ~ Page28



Importation de fichiers musicaux
H H H Utilisez Media Studio pour transférer des
|nSta| |at|0n de Medla StUdIO fichiers musicaux de votre ordinateur vers le

lecteur.

Si Media Studio ne s'installe pas automatiquement

= Installez le programme sur un ordinateur fonctionnant sous Windows 2000 ou Windows XP aprés vous
étre connecté en tant qu'administrateur. Veuillez vous reporter au manuel d'utilisation de I'ordinateur
pour savoir comment vous connecter en tant qu'administrateur.

ATTENTION

Insérez le CD d'installation fourni avec le lecteur dans le lecteur de CD-ROM
de votre ordinateur.

&I Samsung Digita 1 cliquez sur <install now>
7 (Installer maintenant).

User Manual

«OIpMS eIpaA» ap uonejesu]
/XNE2ISNW SI3IYoL 8p Uajsuel]
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Importation de fichiers musicaux

Installation de Media Studio (suite)

SEmeiine) G000

e “ 2 Cliquez sur <NEXT> (SUIVANT).

Rovew st beors cppnafics . ) . .
= L'installation de Media Studio démarre.
i o s s
S e e L

Curert Seltings:

Insallton Type

Instalaton Infomatin
kel P e Saman Ssmsredsiuded
m Folde S arsurghecastudod 1

oot Tams i
sofre fom racenct

D LI\

ﬂ 3 Une fois l'installation a jour terminee, cliquez
sur <Exit> (Quitter).
= Une fois l'installation terminée, une icone apparait

SamsunghediaStudo Setup s prorming the equested operaions.

nasing sur le bureau et Media Studio démarre.

C:AProgram Files\S amsung\S amsunghediaStudiod. 1\himi2052).cab.

T 2% = Si la fenétre de confirmation d'Autoscan apparait,
reportez-vous a la page 25 pour personnaliser les
réglages.




Importation de fichiers musicaux

Branchement de I'appareil sur votre ordinateur

Otez le capuchon USB puis branchez la fiche USB sur le port USB ( \l; ) de votre
ordinateur.
= Toutes les fonctions sont désactivées durant le branchement.

| Configuration requise

Vous pouvez brancher I'appareil sur votre ordinateur si celui-ci est équipé des
composants suivants:

= Pentium 300 MHz ou version ultérieure = Lecteur de CD-Rom (2X ou plus)
= Windows 98SE/ME/2000/XP = Port USB 2.0
= 100 Mo d'espace libre sur le disque dur = DirectX 9.0 ou version ultérieure
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Importation de fichiers musicaux

Ajout de fichiers / dossiers dans Media Studio

Samsung Media Studio

Music s My Life

Samsung Media Studio

At - X MP3 Player  Virus! Device

@ (@ What is Library?

[0 My Folder

FilName size

onye - vorce
Add Folder 3 Besthovents Sympha... 595

. and Ete and you can manage 5 New taes (w742
. e N e 3 b3

Library is a feature that enables you to easily save and manage media fles

Add Folder | Auto Scan

3| sadrFile

» Now Playing

Veuillez vous reporter a la section Aide pour obtenir plus d'informations sur
I'utilisation de Media Studio.

= Cliquez sur <MENU> (MENU) [<Help> (Aide) [_<Help> (Aide) dans le menu situé en haut du
programme Media Studio ou appuyez sur la touche F1 de votre clavier durant la lecture

= Les fichiers qui ont déja été ajoutés a la bibliothéque ne seront plus ajoutés.




= Branchez le lecteur sur l'ordinateur.
= Media Studio doit étre installé sur l'ordinateur.

1 Media Studio démarre automatiquement lorsque vous branchez le lecteur sur votre
ordinateur.
= Sile programme ne démarre pas automatiquement, double-cliquez sur licone Media Studio située
sur le bureau.
2 Cliquez sur I'onglet <Media Library> (Bibliotheque Media) [<library>
(Bibliotheque) situé a gauche de la fenétre Media Studio.

= Les éléments <Add File> (Ajouter un fichier)/<Add Folder> (Ajouter un dossier)/<Auto Scan>
(Balayage automatique) s'affichent.
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| Pour ajouter des fichiers

3 Cliquez sur <Add File> (Ajouter un fichier).
= La fenétre Open (Ouvrir) apparait.

4 Sélectionnez les fichiers que vous souhaitez ajouter
et cliquez sur <Open> (Ouvrir).
= Les fichiers sélectionnés sont ajoutés a la liste.

| Pour ajouter des dossiers

Browse for Folder 2Ix
3 Cliquez sur <Add Folder> (Ajouter un dossier). Slct o,
= La fenétre Browse Folder (Parcourir les dossiers) apparait. o =

Ty Documents
- :

3% Floppy (A1)
Local Disk (C:)

4 Sélectionnez les dossiers que vous souhaitez ajouter
et cliqguez sur <OK>.

= Les dossiers sélectionnés sont ajoutés a la liste.

CO-RiW Drive (F:)
Removable Disk (G:)
Control Panel
Shared Documerts

«0IPMS BIPN» SUBP SIBISSOP / SJa1Ydl) ap Inoly
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Importation de fichiers musicaux

Ajout de fichiers / dossiers dans Media Studio via Autoscan

Samsung Media Studio

HErp T=—Ex
il

Device

Hide Quick Button

Media Library s Libay Atist ~ Q. MP3 Player Virtucl Device

* Media Library.

= [ Ubrary
Al Music
) video
& Photo
@ e ® what is Library?
w1 (T My Folder
Library is a feature that enables you to easily save and manage media files 2UHTS EED
an your computer, (3 YOICE
4| Beethover's Sympho... 599
Library consists of Music. Video, Photo and Etc and you can manage 3] New Stories (Highwa... 747
the corresponding contents using each menu, = [2] markarry.mp3 14.6.
Add File &dd Folder
3 mn Library Functi
+ Now Playing (Ol Ru)




= Branchez le lecteur sur l'ordinateur.
= Media Studio doit étre installé sur I'ordinateur.

1 Media Studio démarre automatiquement lorsque vous branchez le lecteur sur votre
ordinateur.

= Sile programme ne démarre pas automatiquement, double-cliquez sur licone Media Studio située
sur le bureau.

2 Cliquez sur I'onglet <Media Library> (Bibliotheque Media) [<Library>
(Bibliotheque) situé a gauche de la fenétre Media Studio.

= Les éléments <Add File> (Ajouter un fichier)/<Add Folder> (Ajouter un dossier)/<Auto Scan>
(Balayage automatique) s‘affichent.
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3 Cliquez sur <Auto Scan> (Balayage automatique).
= La fenétre Autoscan (Balayage automatique) apparait. [

can manage the found fes using

4 Cliquez sur <OK> (OK). zMM&Zm

= Le balayage des fichiers s'effectue automatiquement et les

URJSOINY BIA OIPNS

BIPSI\ SUEP SIBISSOP / SIBIYDL) ap INoly

fichiers sont ajoutés a la bibliotheque. o
= Lors de votre premiére utilisation de Media Studio, les fenétres
Autoscan Confirm (Confirmation d'Autosccan) et Options
(Options) apparaissent selon le cas. Réglez les options puis [0 =
cliquez sur <OK> (OK) pour lancer Autoscan. coners | SRS SO T

Réglage des options d'Autoscan

Click <MENU> (MENU) [<Tools> (Outils) [<Environment
Settings> (Configuration de I'environnement) en haut de la

B Downlood Folder Setting

Sets lder 0 savefesdonrloaded o e sre and convered by e
=y

Music [DNDacunerts snd SAmg Wy Dosmentsw | Change

oo [0 Bocumerts rd SamaR Y Do | Change

fenétre Media Studio, puis cliquez sur l'onglet <Library> P P (L
(Bibliotheque). e
= Sélectionnez.la gamme et le type de fichier pour lequel vous o Plara ol e e

) ) © bt ton g
souhaitez effectuer un balayage automatique.




Importation de fichiers musicaux

Transfert de fichiers via Media Studio

Samsung Media Studio =ru-

®

— iz Al
+ Media Library
= EJ Ubrary

Type Tite File Name:

wena  Symphony No. 9 (Scherzo) Beethoven's Symphony Na. 3 (Sche.
e Highway Blues" New Staries (Highway Blues) wma

1
2

3 | mes markany.mp3 markany mp3
4 | wmn windows welcome music tile wna

. 599
7420
14.6

Device Connection 2
window

0/4 | 000MB/3BIME

* Now Playing

= La technologie de reconnaissance musicale et les données relatives sont fournies par Gracenote
s et Gracenote CDDBR Music Recognition Service™".

= CDDB est une marque déposée de Gracenote. Le logo et le logotype de Gracenote, le logo et le
logotype Gracenote CDDB et le logo «Powered by Gracenote CDDB» sont des marques
déposées de Gracenote. Music Recognition Service et MRS sont des marques de service de
26 Gracenote.




= Branchez le lecteur sur l'ordinateur.
= Media Studio doit étre installé sur l'ordinateur.

1 Media Studio démarre automatiquement lorsque vous branchez le lecteur sur votre
ordinateur.

= Sile programme ne démarre pas automatiquement, double-cliquez sur licéne Media Studio située
sur le bureau.

Double-cliquez sur le dossier de votre choix dans la fenétre Device Connection
(Connexion de I'appareil) a droite de la fenétre Media Studio.
= Les fichiers contenus dans le dossier s'affichent.

3 Cliquez sur I'onglet <Media Library> (Bibliotheque Media) situé a gauche de la
fenétre Media Studio.

4 Cliquez sur <Music> (Musique).
= Une liste de fichiers s'affiche dans la fenétre centrale.

5 Cochez les fichiers musicaux a transférer dans la liste de la fenétre centrale.
= L'icone Transmit (Transmettre) apparait.

6 Cliquez sur <Transmit> (Transmettre).
= Les fichiers sélectionnés sont transférés vers le lecteur.

= Ne débranchez pas la fiche USB durant le transfert sous peine d'endommager le lecteur ou

ATENTON l'ordinateur.

REMARQUE

= Les fichiers ne sont pas supprimés de l'ordinateur méme s'ils sont transférés vers le lecteur.
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Utilisation du lecteur en tant que disque amovible

Vous pouvez utiliser le lecteur comme appareil de stockage de données amovible.

= Branchez le lecteur sur l'ordinateur.

i eceamras o5 1 Ouvrez les fichiers/dossiers a transférer a
O~ ©: 3] Penines) W, S partir de I'ordinateur.
Ee 2 Cliquez sur <My Computer> (Poste de
()= travail) [<Removable Disk> (Disque

amovible) & partir du bureau.

3 Sélectionnez les fichiers/dossiers que vous
souhaitez transférer depuis votre
ordinateur et faites un cliquer-glisser vers
le dossier de votre choix dans <Removable
Disk> (Disque amovible).
= Les dossiers ou fichiers sélectionnés sont

transférés vers le lecteur.

Qo=

Le message <USB Transferring> (Transfert USB) s'affiche durant le transfert. Débrancher la fiche USB tant
que le message <USB Transferring> (Transfert USB) est affiché peut entrainer un dysfonctionnement de
l'appareil.

L'ordre dans lequel les fichiers musicaux sont affichés dans I'explorateur Windows peut étre différent de
l'ordre de lecture de l'appareil.

Si vous transférez un fichier DRM (fichier chargé) vers le disque amovible, le fichier ne sera pas Iu.

ATTENTION

= Sélectionnez le fichier que vous souhaitez enregistrer et faites un cliquer-glisser sur licéne du disque
amovible. Si vous changez le nom des fichiers musicaux (qui apparaissent dans I'ordre numérique,
alphabétique) dans I'explorateur Windows (ex. : 001* * * , 002* * *...), les fichiers musicaux sont lus dans
I'ordre des numéros indiqué.

= Qu'est-ce que les DRM ?

La technologie et le service DRM (Gestion des droits numériques) permettent d'éviter l'utilisation illégale de
données numériques et de protéger les détenteurs de droits d'auteur. Les fichiers DRM sont des fichiers
musicaux chargés pour lesquels s'applique la technologie de protection concernant les copies illégales de
fichiers musicaux MP3 obtenus de fagon Iégale.



Debrancher I'appareil de I'ordinateur

Suivez les étapes ci-dessous pour éviter d'endommager I'appareil et les données au moment du

débranchement.
5 1 Positionnez le curseur de la souris sur
- licone §@ située sur la barre des
3 taches en bas a droite du bureau et
cliquez sur le bouton gauche de la
souris.

2 Cliquez sur le message <Safely
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1 Remove USB Mass Storage Device
a Drive> (Retirer en toute sécurité le
7y I lecteur USB grande capacité).

= Apres avoir cliqué sur < Safely Remove
USB Mass Storage Device Drive>
ke (Retirer en toute sécurité le lecteur USB

2 grande capacité), I'appareil ne pourra pas

2 étre rechargé méme s'il est connecté a
l'ordinateur.

P’ 3 Débranchez le lecteur de I'ordinateur.

2 [Safely remove LUSE Mass Storage Device - Drive(G:)]

v

= Ne débranchez pas le lecteur de I'ordinateur durant le transfert. Les données ou I'appareil
risqueraient d'étre endommageés.
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ATTENTION
= Vous ne pouvez pas retirer le matériel pendant que des fichiers contenus dans le lecteur sont lus

sur l'ordinateur. Veuillez réessayer une fois la lecture des fichiers terminée.

N
©



= Avant de démarrer!
Transférez le fichier musical de votre choix depuis I'ordinateur vers le lecteur.




Ecouter de la musique

Ecouter de la musique

Branchez les écouteurs sur le lecteur, mettez I'appareil sous tension et vérifiez
I'état de la batterie.

> [00/0020 I NOR. ]
Singer - Song 1
) 00:00:20

| Mode Pause (Pause)

1 Appuyez longuement sur le bouton [M] pour
accéder a I'écran de menu.

2 Appuyez sur le bouton [ +, - ] pour sélectionner
<Music> (Musique) [FJ.

3 Appuyez sur le bouton [M].
= La lecture de musique démarre.

= Les fichiers musicaux compatibles avec le lecteur sont aux
R0 formats MP3, WMA, Ogg et Audio ASF

YT w Les fichiers MP1 ou MP2 possédant uniguement une
extension modifiée vers MP3 peuvent ne pas étre lus.

11 0009 /0020 NOR,_ (i
Singer - Song 1
) 00:00:20

1 Appuyez sur le bouton [ »11] lorsque la lecture de
la musique est en cours.
= La lecture de la musique est interrompue.
Appuyez sur le bouton [ 11 ] une nouvelle fois.
= La lecture reprend a I'endroit ou vous l'avez suspendue.

% = L'appareil s'éteint automatiquement lorsque aucun des
boutons n'est actionné pendant une durée prédéfinie (par

REMARQUE
" gefaut : 10 secondes) en mode Pause (Pause). = Page 43
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Ecouter de la musique

Ecouter de la musique (suite)

| Pour effectuer une recherche a I'intérieur d'une plage

1 Appuyez longuement sur le bouton [I” *Jou[~ "I] pendant que la plage
sélectionnée est en cours de lecture.

= Ces boutons permettent d'effectuer la recherche vers le début ou la fin de la plage.
2 Relachez le bouton dés que vous souhaitez reprendre la lecture.

= La lecture reprend au point ol vous avez relaché le bouton.

| Lecture de la plage en cours a partir du début

Appuyez sur le bouton [ " ¥ ] apres 5 secondes de lecture.
= La plage en cours est lue a partir du début.

| Lecture de la plage précédente/suivante

Appuyez sur le bouton [I” ¥ ] dans les 5 premieres secondes de lecture.
= La lecture de la plage précédente démarre.

Appuyez sur le bouton [~ "I].

= La lecture de la plage suivante démarre.

= Pendant la lecture de fichiers VBR, la plage précédente peut ne pas étre lue méme si vous appuyez sur
aavmoy le bouton [1M ] dans les 5 premiéres secondes de lecture.

= Appuyez sur le bouton [ I"~ ] dans les 5 premiéres secondes de lecture pour passer a la plage

MA récédente.
2 REVARQE P




| Recherche d'un fichier musical

& Singer - Song 1

¢ Singer - Song 2
& Singer - Song 3
¢ Singer - Song 4

1

w

Appuyez sur le bouton [M] lorsque la lecture de
la musique sélectionnée est en cours.

= La liste des fichiers figurant dans le dossier apparait.

Appuyez sur le bouton [ I* ] pour accéder au
dossier précédent.

Appuyez sur le bouton [ +, - ] pour sélectionner le
dossier de votre choix.

Utilisez le bouton [~ "I] pour accéder a la liste de
fichiers dans le dossier sélectionné.
= Utilisez le bouton [~ "] pour accéder au niveau inférieur

et sur le bouton [ I"~ ] pour accéder au niveau supérieur.

Appuyez sur le bouton [ +, - ] pour sélectionner
le fichier de votre choix.

Appuyez sur le bouton [M].
= La lecture du fichier sélectionné démarre.
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Ecouter de la musique

POUI‘ Ilre u ne I ISte de |eCtU re Vous pouvez facilement écouter votre musique

préférée en I'ajoutant a une liste de lecture.

| Pour créer votre propre liste de lecture

J Snger ~Song 1 1 Appuyez sur le bouton [M] lorsque la lecture de
* Singer - Song 2

i la musique est en cours.
& Singer - Song 3

X = La liste des fichiers figurant dans le dossier apparait.
¢ Singer - Song 4 9 PP

2 Appuyez sur le bouton [ I ¥, "~ I, +, -] pour
ajouter des fichiers a la liste de lecture, puis
appuyez sur le bouton [ @ USER/ e»e ].

= ¥ s'affiche devant les fichiers sélectionnés qui sont
ensuite ajoutés a la liste de lecture.

= Pour supprimer des fichiers de la liste de lecture, sélectionnez les % fichiers & supprimer, puis appuyez
RENARQLE a nouveau sur le bouton [ @ USER/ e @].




| Pour lire une liste de lecture

g B .

B.  Playlist

1

2

Appuyez longuement sur le bouton [IM] pour
accéder a I'écran de menu.

Appuyez sur le bouton [ +, - ] pour sélectionner
<Playlist> (Liste de lecture) [, puis appuyez sur
le bouton [M].

= La liste de lecture spécifiée s'affiche.

Appuyez sur le bouton [ +, - ] pour sélectionner
la liste que vous souhaitez lire, puis appuyez sur
le bouton [M].

= La lecture des fichiers contenus dans la liste de
lecture démarre.
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Ecouter de la musique

Fonction de personnalisation du bouton User

Pour plus de commodité, personnalisez les boutons avec les fonctions les plus souvent utilisées.

| Pour définir le mode du bouton User

© Repeat AB 7

O DNSe
O Play Speed
O Play Mode L

Pour effectuer un changement de mode simple, utilisez
le bouton [ @ USER/ eme ] pendant la lecture.

1
2

4

Appuyez longuement sur le bouton [M] pour
accéder a I'écran de menu.

Appuyez sur le bouton [ +, - ] pour sélectionner
<Settings> (Réglages), puis appuyez sur le bouton
[M].

= Le menu Settings (Réglages) apparait.

Appuyez sur le bouton [ +, - ] pour sélectionner
<User Button Mode> (Mode du bouton User), puis
appuyez sur le bouton [M].

= Le menu User Button Mode (Mode du bouton User) apparait.

Appuyez sur le bouton [ +, - ] pour sélectionner le
mode du bouton User de votre choix, puis appuyez
sur le bouton [M].

= <Repeat AB> (Répéter AB) : permet de régler la répétition

d'un segment.

= <DNSe> (Egaliseur) : permet de sélectionner le mode sonore.
= <Play Speed> (Vitesse de lecture) : permet de choisir une

vitesse de lecture (rapide ou lente).

= <Play Mode> (Mode de lecture) : permet de sélectionner le

mode de répétition de la lecture



| Pour définir la répétition d’un segment

» 000%/0020 feg @ Cette fonction vous permet d'écouter des parties
spécifiques d'une plage d'une fagon répétée.

Singer - Song 1 Recommandée pour I'apprentissage d'une langue.

) 00:00:20 1 Réglez le mode du bouton User sur <Repeat AB>

(Répéter AB) et lancez la lecture du fichier de votre
choix.

2 Appuyez sur le bouton [ @ USER/eme ] au début du
segment que vous souhaitez répéter

= Le début est défini et <A — > apparait sur I'écran d'affichage.

3 Appuyez sur le bouton [ @ USER/ eme ] pour définir
la fin du segment que vous souhaitez répéter.

= <A-— B> s'affiche a I'écran et la lecture répétée de la
section spécifiée démarre.

| Pour annuler la répétition du segment

Appuyez sur le bouton [ @ USER/ ee e ] pendant la répétition du segment.
= La répétition du segment est annulée.

Q = La répétition du segment s'annule automatiquement dans les cas suivants :

- lorsque le bouton [I* ] ou [* "I] est actionné pour aller a la plage précédente ou suivante ;

- lorsque le début du segment a répéter est défini mais que la fin ne I'est pas avant que la plage en
cours ne se termine.

REINROUE

Jasn uownog np

uonesijeuuosiad ap uondUOS

Q
=7
=
=5
I
o
m
=)
S
=
A
o
5
=
=l
=
2,
=
=
>

37



38

Ecouter de la musique

Fonction de personnalisation du bouton User (suite)

| Pour utiliser le bouton DNSe (Egaliseur)

Réglez le mode du bouton User sur <DNSe> (Egaliseur) et appuyez sur le bouton
[@USER/eme].

= Chaque fois que vous appuyez sur le bouton, les options du mode DNSe (Egaliseur) défilent dans
I'ordre suivant : <XNORMAL> (NORMAL) <ROCK> (ROCK) <HOUSE> (HOUSE) <JAZZ> (JAZZ)
<DANCE> (DANCE) <BALLAD> (BALLADE) <R&B> (R&B) <CLASSICAL> (CLASSIQUE)
<USER EQ> (EGALISEUR PERSONNALISE) <3D USER> (PERSONNALISE 3D) <3D STUDIO>
(STUDIO 3D) <3D STAGE> (PLATEAU 3D) <3D CLUB> (CLUB 3D).

| Pour utiliser le bouton de vitesse de lecture

Réglez le mode du bouton User sur <Play Speed> (Vitesse de lecture) et appuyez sur le
bouton [@ USER/ eme].

= Chaque fois que vous appuyez sur le bouton, les options du menu Vitesse de lecture défilent dans
l'ordre suivant : <x0.7> <x0.8> <x0.9> <x1.0> <x1.1> <x1.2> <x1.3>.

| Pour utiliser le bouton du mode de lecture

Réglez le mode du bouton User sur <Play Mode> (Mode de lecture) et appuyez sur le
bouton [@ USER/ eme].
= Chagque fois que vous appuyez sur le bouton, les options du mode de lecture défilent dans

I'ordre suivant : <Normal> (Normal) <Repeat All> (Répéter tout) <Repeat One> (Répéter une)
<Shuffle All> (Lecture aléatoire de la totalité).



Enregistrement

Enregistrement vocal
o m 1 Appuyez longuement sur le bouton
BV003.WAV [oUSER/eme]. o
= L'enregistrement vocal démarre des I'affichage du
00:07:30 / 00:11:10 nom de fichier.

2 Appuyez a nouveau sur le bouton [ @ USER/ eme |
pour arréter I'enregistrement.
= Apres l'affichage du message indiquant la fin de

I'enregistrement, les données sont automatiquement
enregistrées dans le dossier <VOICE> (VOIX).

Noms des fichiers pendant I'enregistrement

Les fichiers “WVNNN.WAV” sont spécifiés pendant I'enregistrement.

V signifie qu'il s'agit d'un fichier d'enregistrement vocal, NNN définit le nombre
d'enregistrements et .\WAV correspond au format du fichier.

Par exemple, un fichier appelé VO03.WAV est le troisieme fichier d'enregistrement
vocal enregistré.

= Pour écouter les fichiers enregistrés, utilisez la fonction Navigation (Navigation) (Recherche).
REMARQUE "~ Page 15.

n Ne tenez pas le microphone trop rapproché ou trop éloigné de la cible d'enregistrement au risque
ATTENTION daffecter la qualité de ce dernier.

L'enregistrement vocal n’est pas optimal lorsque la batterie est trop faible.

[20A JusWaSIBaIuT/Iasn uoNog
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Réglages
Vous pouvez définir des réglages détaillés pour la

Réglage de Ia mUSIque lecture de données musicales.

> 1 Appuyez longuement sur le bouton [M] pour
= 3D User Set > accéder a I'écran de menu.
= User EQ Set >
" Play Mode P
Y v 2 Appuyez sur le bouton [ +, - ] pour sélectionner

<Settings> (Réglages), puis appuyez sur le bouton
[M].

= Le menu Settings (Réglages) apparait.

3 Appuyez sur le bouton [ +, - ] pour sélectionner
<Music> (Musique), puis appuyez sur le bouton
[M]

= Le menu Music (Musique) apparait.
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4 Utilisez les boutons [ +, - ] et [M] pour définir les
fonctions nécessaires.

(Q = Fonctions des boutons a utiliser pendant le réglage :
wRo - Appuyez sur le bouton [IV *] pour aller a I'élément précédent.
" - Appuyez sur le bouton [* “I] pour aller & I'élément suivant.
- Appuyez sur le bouton [+, -] pour vous déplacer vers le haut ou vers le bas dans le menu actuel.
- Appuyez sur le bouton [ M ] pour sélectionner ou enregistrer le menu.
= Si aucun bouton n'est actionné sur I'écran Settings (Réglages) pendant environ 30 secondes,
réglages sont annulés et reviennent a ceux définis a l'aide de la fonction précédente.
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Réglages

Réglage de la musique (suite)

= DNSe : vous permet de sélectionner |'effet sonore adapté au genre musical. Options disponibles :
<3D-User> (Personnalisé 3D) <3D-Studio> (Studio 3D) <3D-Stage> (Plateau 3D) <3D-Club> (Club 3D)
<Normal> (Normal) <Rock> (Rock) <House> (House) <Jazz> (Jazz), <Dance> (Dance) <Ballad>
(Ballade) <R&B> (R&B) <Classical> (Classique) ou <User EQ (Egaliseur personnalisé).

= Réglage 3D User (Personnalisé 3D) : permet de régler I'effet sonore 3D et le renforcement des
basses. Leffet 3D peut étre réglé entre 00 et 05 et le renforcement des basses entre 00 et 03.
Pour utiliser cette fonction, sélectionner <3D User> (Personnalisé 3D) dans le menu <DNSe>.

= Réglage User EQ (Egaliseur personnalisé) : permet de sélectionner directement un effet sonore
(EQ). Pour utiliser cette fonction, sélectionnez <User EQ> (Egalisateur personnalisé) dans le menu
<DNSe> (DNSe).

= Play Mode (Mode de lecture) : permet de sélectionner le mode de lecture tel que les paramétres
de répétition. Options disponibles : <Normal> (Normal) <Repeat All> (Répéter tout) <Repeat One>
(Répéter une) <Shuffle All> (Lecture aléatoire de la totalité) et <Intro> (Intro).

= Play Speed (Vitesse de lecture) : permet de réglez la vitesse de lecture de I'enregistrement
musicallvocal. Options disponibles : <x0.7> <x0.8> <x0.9> <x1.0> <x1.1> <x1.2> ou <x1.3>
(plus le nombre est élevé, plus la vitesse de lecture sera rapide).

= Skip Interval (Intervalle de saut) : permet de régler l'intervalle lorsque vous appuyez sur le bouton
[I” “Jou[" "] pendant la lecture. Options disponibles : <1 Track> (1 plage) <03 Sec> (3 s)
<05 Sec> (5 s) <07 Sec> (7 s) <10 Sec> (10 s) <30 Sec > (30 s) ou <01 Min> (1 min).

= Search Speed (Vitesse de recherche) : permet de régler la vitesse de recherche lorsque vous
appuyez sur le bouton [I¥ “]ou [~ "I] pendant la lecture. Options disponibles : <01 Sec> (1 s)
<03 Sec> (3 s) <05 Sec> (5 s) <10 Sec> (10 s) <15 Sec> (15 s) <20 Sec> (20 s) <30 Sec > (30 s)
ou <01 Min> (1 min).

= Intro Time (Durée de I'intro) : Lorsque vous sélectionnez la fonction Intro (Intro) dans <Play Mode>
(Mode de lecture), le début de tous les fichiers est lu pendant le nombre de secondes que vous avez
définies. Options disponibles : <10 Sec> (10 s) <20 Sec> (20 s) <30 Sec > (30 s) ou <60 Sec> (60 s).

= Pour les fichiers VBR ou Ogg, l'intervalle de saut et la vitesse de recherche peuvent ne pas étre exacts.
REVARQE w Qur'est-ce que le DNSe ?

Le DNSe est un effet sonore des lecteurs MP3 développé par Samsung. Il se compose des modes

3D (3D). Le mode 3D (3D) permet d'ajouter un effet stéréophonique a la musique.




Réglages
Vous pouvez régler les fonctions liées au minuteur d'arrét et a

Réglage de I'heure l'arrét automatique.

1 Appuyez longuement sur le bouton [M] pour

= Auto Power Off > accéder a I'écran de menu.

< Return

2 Appuyez sur le bouton [ +, - ] pour sélectionner
<Settings> (Réglages), puis appuyez sur le bouton
[M].

= Le menu Settings (Réglages) apparait.

3 Appuyez sur le bouton [ +, - ] pour sélectionner
<Time> (Heure), puis appuyez sur le bouton [M].
= Le menu Time (Heure) apparait.
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4 Utilisez les boutons [ +, - ] et [M] pour définir les
fonctions nécessaires.

<Sleep> (Mise en veille automatique) : permet d'éteindre
automatiquement I'appareil apres I'écoulement de la durée
préréglée. Options disponibles : <Off> (Désactivé) <15 Min>
(15 min) <30 Min> (30 min) <60 Min> (60 min) <90 Min>
(90 min) ou <120 Min> (120 min).

<Auto Power Off> (Heure d'arrét automatique) : permet
d’éteindre automatiquement I'appareil lorsque aucun bouton
n'est actionné avant I'écoulement de la durée préréglée en
mode Pause (Pause). Options disponibles : <Off> (Désactivé)
<05 Sec> (5 s) <10 Sec> (10 s) <15 Sec> (15 s) <30 Sec>
(30 s) <01 Min> (1 min) ou <03 Min> (03 min).
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= Scroll Speed >H

Réglages

Réglage de I'af'nchage Vous pouvez régler les fonctions liées au défilement, au

rétroéclairage et aux autres affichages a I'écran.

1 Appuyez longuement sur le bouton [M] pour

Backlight Time > accéder a I'écran de menu.

Contrast > P

Tag N 2 Appuyez sur le bouton [ +, - ] pour sélectionner
v

<Settings> (Réglages), puis appuyez sur le bouton
[M].

= Le menu Settings (Réglages) apparait.

3 Appuyez sur le bouton [ +, - ] pour sélectionner
<Display> (Affichage), puis appuyez sur le
bouton [M].
= Le menu Display (Affichage) apparait.

4 Utilisez les boutons [ +, - ] et [M] pour définir les
fonctions nécessaires.

<Scroll Speed> (Faire défiler) : permet de régler la vitesse de défilement du titre de la plage.
Options disponibles : <Slow> (Lent), <Normal> (Normal) et <Fast> (Rapide).

<Backlight Time> (Rétroéclairage) : permet d'arréter automatiqguement I'appareil lorsque aucun
bouton n'est actionné durant la période préréglée. Options disponibles : <05 Sec> (5 s), <15 Sec>
(15 s), <30 Sec> (30 s), <60 Sec> (60 s) ou <Always On> (Toujours activé).

<Contrast> (Contraste) : permet de régler la luminosité de I'écran d'affichage. Options disponibles :
valeurs comprises entre 00 et 10.

<Tag> (Etiquette) : permet d’afficher les informations concernant les plages des fichiers musicaux
gréce a l'étiquette ID3. Options disponibles : <On> (Activé) ou <Off> (Désactivé).

<Display Time> (Durée a I’écran) : permet de contrdler la durée pendant la lecture de la musique.
Sélectionnez <Play Time> (Durée de lecture), <Remain Time> (Durée restante) ou <Total Time>
(Durée totale).

<LED Effect> (Effet DEL) : Permet de sélectionner I'effet de rétroéclairage de la DEL. Options
disponibles : <Off> (Désactivée), <Button> (Bouton) (s'allume lorsque vous appuyez sur un bouton),
<Random> (Aléatoire) ou <Always on> (Toujours allumée).



Réglages

A Permet de définir la langue du menu et des informations
Reglage de Ia Iangue concernant la plage (étiquette 1D3).

1 Appuyez longuement sur le bouton [IM] pour

: :53;—Tag > accéder a I'écran de menu.
eturn
2 Appuyez sur le bouton [ +, - ] pour sélectionner
<Settings> (Réglages), puis appuyez sur le bouton
[M].

= Le menu Settings (Réglages) apparait.

3 Appuyez sur le bouton [ +, - ] pour sélectionner
<Language> (Langue), puis appuyez sur le
bouton [M].
= Le menu Language (Langue) apparait.

4 Utilisez les boutons [ +, - ] et [M] pour définir les
fonctions nécessaires.
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= <Menu>(Menu) : permet de régler la langue du menu. Options disponibles : <Chinese(S)>
<Chinese(T)> <Dutch> <English> <French> <German> <Hungarian> <lItalian> <Japanese>,
<Korean> <Polish> <Portuguese> <Russian> <Spanish> et <Swedish>.

= <ID3-Tag> (Etiquette ID3) : permet de régler la langue des informations concernant la plage. 0 0
Options disponibles : <Afrikaans> <Basque> <Catalan> <Chinese(S)> <Chinese(T)> <Czech> 8‘8‘
<Danish> <Dutch> <English> <Estonian> <Finnish> <French> <German> <Greek> <Hrvatski> )
<Hungarian> <Icelandic> <Italian> <Japanese> <Korean> <Norwegian> <Polish> <Portuguese> % ‘-g
<Romany> <Russian> <Slovak> <Slovene> <Spanish> <Swedish> <Thai> <Turkish> et oo
<Vietnamese>. o @
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(Q = Les langues prises en charge peuvent étre modifiées ou ajoutées. «é g_—;
REWRQE = Qu'est-ce que I'étiquette ID3 ? @ Lg
Il s'agit d'un élément attaché a un fichier MP3 contenant les informations relatives au fichier telles que le -

titre, l'artiste, I'album, l'année, le genre et un champ commentaire.
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Réglages

4 A Vous pouvez régler les fonctions Default Volume (Volume par
Reglage du SySteme défaut), Resume (Reprise) et Beep Sound (Signal sonore).

= Bit Rate >H

= Delete File
= Resume
" Beep

>
>
>

v

1
2

Appuyez longuement sur le bouton [M] pour
accéder a I'écran de menu.

Appuyez sur le bouton [ +, - ] pour sélectionner
<Settings> (Réglages), puis appuyez sur le bouton
[M].

= Le menu Settings (Réglages) apparait.

Appuyez sur le bouton [ +, - ] pour sélectionner
<System> (Systéme), puis appuyez sur le
bouton [M].

= Le menu System (Systeme) apparait.

Utilisez les boutons [ +, - ] et [M] pour définir les
fonctions nécessaires.



= <Bit Rate> (Débit binaire) : permet de régler la qualité d'enregistrement. Options disponibles :
<32kbps> (32 kbps) <64kbps> (64 kbps) ou <128kbps> (128 kbps) (plus le nombre est élevé,
plus la taille du fichier sera grande).

<Delete File> (Supprimer) : permet de rechercher et de supprimer les fichiers sur I'écran
Navigation (Navigation). ~ Page 48

<Resume> (Reprise) : permet de spécifier le point de reprise de la lecture lorsque vous avez
interrompu la plage musicale en cours de lecture. Si <Off> (Désactivé) est sélectionné, la lecture
reprend au début du dernier fichier écouté. Si <On (Activé)> est sélectionné, la lecture reprend a
I’endroit ou elle a été interrompue.

<Beep> (Signal sonore) : permet d'activer ou de désactiver I'émission d'un signal sonore lors du
fonctionnement d'un bouton. Options disponibles : <On> (Activé) ou <Off> (Désactivé).

<Default Vol> (Vol. par défaut) : le volume par défaut peut étre réglé sur une valeur comprise
entre 00 et 30 (maxi.). Si I'appareil est remis sous tension une fois que le volume a été réglé
au-dessus de la valeur par défaut, la lecture s'effectue en fonction du volume par défaut.

Si I'appareil est remis sous tension une fois que le volume a été réglé dans la plage par défaut,
la lecture s'effectue en fonction du volume préalablement utilisé.

<Default Set> (Réglage par défaut) : permet de revenir aux valeurs de réglage par défaut.
~ Page 48
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= <About> (A propos de) : permet de contrdler les informations suivantes : la version du 8‘
micrologiciel, le nombre de fichiers enregistrés et la mémoire restante. >

Q

)

o

= A propos de la mémoire intégrée g
REMARQLE La taille de la mémoire intégrée réelle disponible est Iégérement inférieure a celle indiquée, car le ﬁ
micrologiciel interne en utilise une partie. @

3
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Réglages

Réglage du systéme (suite)

Pour supprimer un fichier

= BitRate S A Ap,pu,yez sur le bouton [I* ~] pour aller au dossier
* Delete File > précedent.

® Resume > @ Appuyez sur le bouton [ +, - ] pour sélectionner le
" Beep > dossier de votre choix.

Utilisez le bouton [~ ~I] pour accéder a la liste des
fichiers du dossier sélectionné.

= Utilisez le bouton [~ *I] pour accéder au niveau inférieur et
le bouton [I* ¥] pour accéder au niveau supérieur.

Appuyez sur le bouton [ +, - ] pour sélectionner un
fichier a supprimer, puis appuyez sur le bouton [M].

Appuyez sur le bouton [ +, - ] pour sélectionner
<Confirm> (Confirmer), puis appuyez sur le bouton [M].
= Le fichier sélectionné est supprimé.

= Les fichiers ne peuvent pas étre récupérés une fois supprimés.
gy Sovez sOr de vouloir les supprimer avant d'effectuer 'opération.

Réglages par défaut

= Default Vol > H Appuyez sur le bouton [ +, - ] pour sélectionner <Yes>

= Default Set > (Oui) ou <No> (Non), puis appuyez sur le bouton [M].

= About > = <Yes> (Oui) : permet d'initialiser tous les réglages par défaut.
< Return v = <No> (Non) : permet d'annuler les réglages par défaut.




tialisation du systéme. .................. 50
nnage 51
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Rélnltlallsatlon du SyStéme Si un dysfonctionnement de I'appareil survient,

vous pouvez réinitialiser le systeme en appuyant
sur le bouton Reset.

MIC  RESET
o e

Bouton Reset

Appuyez sur le bouton Reset situé sur la partie inférieure de I'appareil a I'aide d'un objet

pointu, comme une agrafe.
= Le systéme est réinitialisé.

= La fonction Reset (Réinitialisation) ne permet pas de supprimer les données enregistrées dans la

mémoire intégrée.



D é an n a e Si un dysfonctionnement survient, vérifiez les points suivants.
p g Si le probléme persiste, contactez le centre de dépannage Samsung le plus proche.

Probléme Points de contrdle et dépannage

L il all = L'appareil ne s'allume pas si la batterie est entierement
ElIEENE 2 SENnE déchargée. Rechargez la batterie et remettez I'appareil sous
pas. tension.

= Appuyez sur le bouton Reset.

= Vérifiez si l'interrupteur [HOLD] est dirigé dans le sens de la
fleche.

= Vérifiez que vous avez appuyé sur le bouton adéquat, puis
essayez a houveau.

= Appuyez sur le bouton Reset.

Les boutons ne
fonctionnent pas.

= Sivous avez sélectionné <Backlight Time> (Rétroéclairage)
dans le menu <Settings> (Réglages) [<Oisplay>
L'écran ne s'allume pas. (Affichage), I'écran est peut-étre éteint. Appuyez sur
n'importe quel bouton pour rallumer I'écran.
= |l se peut que les données affichées a I'écran ne soient pas
visibles sous les rayons directs du soleil.
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L'alimentation se coupe automatiquement lorsque la batterie

Lalimentation est coupée. est entierement déchargée. Rechargez la batterie.

I'exposez a des températures basses ou élevées pendant
des périodes prolongées.

2]
3 &
= >
= Les réglages EQ (Egaliseur), LED Effect (Effet LED) ainsi C3D 52
La durée de vie de la que les autres réglages peuvent varier en fonction de la @ =
batterie différe de celle durée d'utilisation. o8
spécifiée dans le manuel. = La durée de vie de I'appareil peut étre réduite si vous 2 =
£
=
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Dépannage (suite)

Probléme Points de contrdle et dépannage

La lecture est
désactivée.

Le téléchargement du
fichier est désactivé.

Des fichiers ou des
données manquent.

Affichage anormal de la
durée de lecture.

Affichage anormal du
nom de fichier.

= Vérifiez que le fichier disponible a bien été enregistré dans la
mémoire.

= Assurez-vous que le fichier musical n’est pas endommagé.

= Vérifiez que la puissance de la batterie est suffisante.

= Vérifiez que la fiche USB est correctement branchée, puis
rebranchez-la.

= Vérifiez que la mémoire est pleine.

= Appuyez sur le bouton Reset.

Vérifiez que la fiche USB n’a pas été débranchée durant le
transfert des fichiers ou des données. Si tel est le cas, les
fichiers/données et méme I'appareil risquent d'étre
endommagés. Vous devez faire preuve d'une grande prudence
car Samsung ne peut en aucun cas étre tenu responsable de
la perte des données.

Vérifiez que le fichier est au format VBR (débit binaire variable).

Allez dans <Settings> (Paramétres) [<[hnguage> (Langue) [
<ID3-Tag> (Etiquette ID3) dans I'écran de menu et sélectionnez la
langue appropriée.



Probléme Points de contrdle et dépannage

Dysfonctionnement du Vérifiez que la configuration requise de I'ordinateur a été
programme. correctement établie.

= (Sous Windows 98SE) Vérifiez que le pilote USB est installé
et procédez a l'installation s'il ne I'est pas.

:Tgr‘é?:aqzﬁll?:s? = (Sous Windows MEIZOOQIXP} _Clique_z sur le menu I_)émarrer
2 A du bureau et lancez la mise a jour Windows. Sélectionnez
désactivée. les derniéres mises a jour critiques et 'ensemble des
modifications provisoires, puis lancez la mise a jour.
Redémarrez votre ordinateur et rebranchez le lecteur.
Le rétroéclairage ne = Contrélez la durée du rétroéclairage.
s'allume pas. = Vérifiez la batterie.

. Les phases de chargement peuvent générer de la chaleur.
L'appareil est chaud. Cela n'a aucune incidence sur la durée de vie de l'appareil ou
sur son fonctionnement.
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Installation
Spécifications du produit........ccc............



Ar bo rescence d €S MEeNUS Cette fonction vous permet d'obtenir un

apercu rapide de la structure des menus.

Ecran de sélection du menu

Music Navigation Playlist Settings
[ | | | | 1
Music User Button Mode Time Display Language System
DNSe Repeat AB Auto Sleep Scroll Speed Menu Bit Rate
3D User Set DNSe Auto Power Off  Backlight Time ID3-Tag Delete File
User EQ Set  Play Speed Contrast Resume
Play Mode Play Mode Tag Beep
Play Speed Display Time Default Vol
Skip Interval LED Effect Default Set
Search Speed About

Intro Time
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Installation manuelle du pilote USB

Installez le pilote USB manuellement lorsque l'installation automatique n'est pas possible ou
lorsqu'une erreur s'est produite lors de l'installation.

= Insérez le CD d'installation dans le lecteur de CD-ROM de l'ordinateur.

| Si une erreur se produit lors de I'installation du pilote USB

1 Vérifiez le gestionnaire de périphériques.
Windows 98SE/ME : Panneau de
configuration CSystéme CGestionnaire
de périphériques
Windows 2000/XP : Panneau de
configuration [_Systéme [Matériel 1
Gestionnaire de périphériques

ou _teb
EEIEIETES X

2 Vérifiez si un périphérique comportant
un point d'exclamation ou d'interrogation
figure dans la liste (affiché comme
périphérique inconnu ou périphérique USB).

3 Double-cliquez sur le périphérique comportant un point
d'exclamation ou d'interrogation.

= Si vous utilisez Windows 2000 et que votre version de Windows ne reconnait pas le pilote USB, veuillez
wpe  tElécharger etinstaller la derniere version de I'ensemble des modifications provisoires a partir du site
¢ windowsupdate.microsoft.com

= La méthode d'installation peut varier en fonction du type d'ordinateur ou du systeme d'exploitation.
Contactez votre vendeur d'ordinateur ou votre centre de services pour obtenir des informations sur
l'installation.

= Si des erreurs se produisent de maniere répétée apres l'installation du pilote USB, rebranchez la fiche
USB aprés le redémarrage de votre systéme.




Une fois le pilote sélectionné,
cliquez sur [Reinstall Driver]
(Réinstaller le pilote).

General | Diver |

@, USB Devic

Devicotyps:  Othar devioes
Mendactaer  Nons speciied.
Hascwaro verson: Not avalable
Devioe stahus

“1 .R.eins.tall Driver |

Sélectionnez [Search for a suitable
driver for my device] (Rechercher un
pilote adapté a mon périphérique),
puis cliquez sur [Next] (Suivant).

anopeang e

This iz parades divers for theflwing e dvice:

S8 Hass Sarga Dvica
=2 =

pefomace of e devee.

\/
<k Careal

5 Cliquez sur [NEXT] (SUIVANT).

Upgrade Device bri

Welcome to the Upgrade Device
Driver Wizard

This wizard helps you upgrade & device dive for 3
harduare device.

To contive, cick

7 Cliquez sur [NEXT] (SUIVANT) pour
terminer.

[Add New Hardware Wizard

This wizard searches for new ives for.

USB Device

A device divet i a softwere progiam that makes
hasdware device work.

=
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Installation manuelle du pilote USB (suite)

| Sous Windows 98SE

Suivez les instructions qui s'affichent & I'écran pour terminer l'installation.

‘Add New Hardware Wizard

Ths wizard searches for rew dhivers for.
(& YP-U2
A device diver it & soltware progiam that makes &
.T hardware devee vk

[Add New Hardware Wizard

What do you want Windows to do?

 {Beaich o the best dive for yout device. |
{Recommended)

" Display alistof sl he divers in a specific
locston, so you can select the diver you want.

‘Windows villssarch o new dives i s ivr dotabase
onyour hatd v andin any of the olowing seected
Iocatirs. Clk et to st th seach

™ Elopp dik dives.

I~ coAoM dive

I~ Miosot Widows Updste

¥ Speciy

Windows iver lasearch for the deice:
Somsung T+ USE Diver
Windons s o sady o st the bestdive o tis

Gevice Cick Back [0 seect e diver, of ik Nest
o conine.

Locatin f diver

g CWINDOWS\NRMUSBAZING

CEED

oo

&— e

R

i

Emplacement du pilote USB
[CD-ROM] \USB Driver\win98 USB

Vous devez redémarrer votre ordinateur pour terminer l'installation.

RENARQUE

= Vous pouvez |'utiliser comme disque amovible sous Windows 98SE si le programme Lecteur n'est pas
installé. Veillez a installer le fichier du pilote USB en premier.




Spécifications du produit

Nom du modéle YP-U2
Alimentation 3,7 V (Lithium-polymere rechargeable)
Alimentation de la batterie intégrée |  280mAh

Capacité de la mémoire intégrée

512MB(YP-U2 X), 1GB(YP-U2 Z), 2GB(YP-U2 Q)

Fichier | Compatibilité

MPEG1/2/2.5 Couche 3 (8 kbps a 320 kbps, 8 kHz a 48 kHz)
WMA, ASF (48 kbps & 192 kbps,8 kHz a 48 kHz), Ogg (Q0 & Q9)

Nombre de dossiers et fchiers supportés|

Dossiers : Max. 2000 Fichiers : Max. 200

Sortie des écouteurs

20mW(France 5SmW/CH)(16<)

Bande de fréquences de la sortie

20 Hz & 20 KHz

Taux de bruit

88 dB avec filtre passe-bas de 20 KHz (sur la base de 1 KHz, 0 dB)

Durée de lecture

13 heures de lecture musicale (MP3 128 kbps, volume 20, Normal mode sonore)

Plage de température pour e fonctonnement

-5a35°C

Etui

Plastique

Poids

289

Dimensions (L x H x P)

24,4 x 87,5 x 12,6 mm

e Le contenu de ce manuel est susceptible d'étre modifié en vue d’'étre amélioré sans
notification préalable.
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Spécifications du produit

L'unité qui se trouve avec ce manuel de I'utilisateur est fournie sous licence sous
certains droits de propriété intellectuelle de parties tierces. Cette licence est limitée a une
utilisation privée non commerciale par I'utilisateur final pour les contenus sous licence.
Aucun droit n’est concédé pour une utilisation commerciale.

Cette licence ne couvre aucun produit autre que celui-ci et ne peut étre étendue a un
produit ou processus qui n'est pas sous licence selon la norme ISO/IEC 11172-3 ou
ISO/IEC 13818-3 utilisé ou vendu avec ce produit.

La licence couvre uniqguement I'utilisation de ce produit pour encoder et/ou décoder

des fichiers audio selon la norme ISO/IEC 11172-3 ou ISO/IEC 13818-3.

Aucun droit n’est cédé sous cette licence pour des caractéristiques ou des fonctions

du produit qui ne sont pas conformes a la norme ISO/IEC 11172-3 ou ISO/IEC 13818-3.



Ce symbole sur le produit ou sa documentation indique qu'il ne doit pas étre
éliminé en fin de vie avec les autres déchets ménagers. L'élimination
incontrolée des déchets pouvant porter préjudice a I'environnement ou & la
santé humaine, veuillez le séparer des autres types de déchets et le recycler
de facon responsable.

Vous favoriserez ainsi la réutilisation durable des ressources matérielles.

Les particuliers sont invités a contacter le distributeur leur ayant vendu le
produit ou a se renseigner aupres de leur mairie pour savoir ou et comment ils
peuvent se débarrasser de ce produit afin qu'il soit recyclé en respectant
I'environnement.

Les entreprises sont invitées a contacter leurs fournisseurs et a consulter les
conditions de leur contrat de vente. Ce produit ne doit pas étre éliminé avec les
autres déchets commerciaux.

(e /)
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Si vous avez des suggestions ou des questions concernant les produits Samsung,
veuillez contacter le Service Consommateurs Samsung.
Samsung Service Consommateurs
082508 6565 ( 0,15/min)
www.samsung.com/fr

REV 0.0
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